
Da Vinci eMAIL for Windows 3.0

Help Index

Welcome

Commands
Create!
Mailbox Menu
Names Menu
Options Menu

Procedures

For information on how to use Help, press <F1> or choose Using Help under Procedures.



Welcome to Da Vinci eMAIL

Da Vinci eMAIL provides the basis for a complete desktop communications solution.    eMAIL puts your 
network to work for you, by enabling you to exchange messages and files with other computer users: In 
your office or around the world.    eMAIL helps you get it right the first time, so that you can increase your 
productivity immediately.

This help system, along with the eMAIL User's Manual, will be your guide to eMAIL.    To find out more 
about the help system, double-click on Using Help in Procedures.

If you are unfamiliar with instructions such as "double-click" or "select," you can find explanations in your 
Microsoft Windows documentation (or ask an experienced Windows user for help).



Create! 

Pressing Create! in the eMAIL Mailbox gives you a Create screen with two menu options: 

File Menu
Edit Menu



Create! File Menu

The Create! File menu includes the following menu options:

Open An Open File window appears.

Save A Save Editor Text window opens.

Print A Print window opens (for header, message, attachment).

Related Topics

Creating a Message
Inserting Text Files Into Your Message
Printing a Message
Saving Your Messages



Create! Edit Menu

The Edit Menu gives you the following editing options:

Undo Cancels the last edit action.

Cut Deletes the selected text into the Windows clipboard.

Copy Copies selected text into the Windows clipboard.

Paste Pastes the contents of the clipboard into the message at the cursor.

Clear Deletes the contents of the clipboard.

Related Topics

Creating a Message
Editing a Message



Mailbox Menu

Open mailbox
Close mailbox
Print message list
Search messages
View message
Save attachment
Delete message
Print message



Mailbox Open Command

The Open Command in the Mailbox menu will open a list box containing the names of all the people who 
are logged into eMAIL at your station. Choose from this list box the mailbox that you want to open.    That 
mailbox will be displayed, and the currently open mailbox will close.



Mailbox Close Command

The Close command in the Mailbox menu will close the currently open mailbox. 



Mailbox Print Message List Command

The Print message list option in the Mailbox menu enables you to print a list of your eMAIL messages.    

(Note: This will not print the text of each message, only the list of messages you see in your Mailbox.)



Mailbox Search Message Command

The larger your mailbox gets, the longer it takes to manually search through it for a specific message or 
type of message.    In such cases, it is much faster to have eMAIL run the search for you electronically.    
The Search message option enables you to search your mailbox for messages that meet your specified 
criteria. 

Related Topic
Searching Your Mailbox



Mailbox View Message Command

Your normal mailbox display includes a list of all the messages in your mailbox, in the reverse order that 
they were received. The View message option enables you to open up a view window to read the 
message.

Related Topic

Viewing a Message 



Mailbox Save Attachment Command

The Save attachment option in the Mailbox menu enables you to save an attached file to your system.

Related Topic

Saving Attached Files 



Mailbox Delete Message Command

To maintain a mailbox with an efficient size, or to free up memory, you may wish to delete some 
messages.    The Delete message option in the Mailbox menu enables you to remove a message 
permanently from your mailbox.

Related Topic

Deleting a Message



Mailbox Print Message Command

This Mailbox menu option enables you to copy an eMAIL message from the computer to paper.    You can 
even print out a large number of messages by multiple selecting all the messages at once and then 
choosing Print message.

Related Topics

Multiple Selection
Printing a Message



Names Menu

Logins
Address book
Mailing list
New
Open
Save
Save As
Print



Logins

The Logins option in the Names Menu enables you to log people in and out.    Logging people in and out 
means adding and removing Login Names.

Related Topic

Using Multiple Logins



Address book

The Address book option in the Names Menu enables you to manipulate your Address Book, which is a 
personal list of names to whom you commonly send mail.

Related Topic

Changing Your Address Book



Mailing lists

Mailing lists are a collection of eMAIL addresses that can conveniently be referred to by one name.    The 
Mailing list option in the Names menu enables you to begin the steps necessary to delete and rename 
Mailing lists, and edit and add Mailing lists.

Related Topic

Using Mailing Lists    



New

The New option in the Names menu enables you to start the process of creating new Names Files, i.e., 
Logins, Address books, and Mailing lists files.

Related Topic

Using Multiple Names Files



Open

Open is an option in the Names menu that enables you to open a Names List. The Names List is a 
Logins, Address book, or Mailing list that you have previously created and stored as a DOS file.

Related Topic

Using Multiple Names Files



Save

When you choose Save from the Names menu, the changes you have made to your Logins list, Address 
book, and Mailing lists are saved.    These saved lists will replace the previous lists.

Related Topic

Using Multiple Names Files



Save As

With the Save As option in the Names menu, you can save a new Names list without losing the old one.

Related Topic

Using Multiple Names Files



Print

Choosing Print from the Names menu enables you to print any of your Names Lists: Logins, Address 
book, Mailing Lists, Public Address Book, and Public Mailing Lists.

Related Topic

Printing Names Lists



 Options Menu

Set Hot Keys
Incoming Beep
Incoming Popup
Change Password



Set Hot Keys

If you choose Set Hot Keys from the Options Menu, you will be able to choose a key sequence to create a
hot key.    The hot key enables you to pull up a Create envelope when eMAIL is in icon form.    After you 
have sent your message, you will be able to return to the program you were previously working on.

Related Topic

Setting the Hot Key



Incoming Beep

An Incoming Beep is a mail alert in the form of a tone sequence. The Incoming Beep option in the Options
menu enables you to choose whether you would like eMAIL to give you a tone sequence when you are 
receiving a message.

Related Topic

Selecting a Mail Alert



Incoming Popup

Selecting Incoming Popup in the Options menu displays a pop-up window when you are receiving a 
message and eMAIL is in icon form.    The pop-up window gives you the option to immediately view and 
respond to the message. 

Related Topic

Selecting a Mail Alert



Change Password

For eMAIL users who are concerned with security, changing your password on a regular basis is a 
valuable precaution.    The Change Password option in the Options menu enables you to change your 
password.

Related Topic 

Changing Your Password



Procedures

Assigning a Message Class
Attaching Files
Attaching the Clipboard
Certifying a Message
Changing Your Address Book
Changing Your Password
Closing eMAIL
Creating a Message
Deleting a Message
Editing a Message
Encrypting a Message
Inserting Text Files
Interpreting Status Tokens
Minimizing eMAIL
Multiple Selection
Printing a Message
Printing Names Lists
Receiving Security Messages
Replying to a Message
Saving Attached Files
Saving Your Messages
Searching Your Mailbox
Selecting a Mail Alert
Sending a Blind Carbon Copy
Sending a Carbon Copy
Sending a Message
Setting the Hot Key
Using Help
Using Mailing Lists
Using Multiple Logins
Using Multiple Names Files
Using the Receiver List
Viewing a Message



Assigning a Message Class

Every message you send will be classified as 1st Class, 2nd Class, 3rd Class, or Priority.    The class will 
show up as a status token in the receiver's mailbox: 1,2, 3, or an exclamation point, respectively.

How to Assign a Message Class

1. In the Deliver Box (the box in which you specify the receivers of a message), click the 
appropriate class button.

The message will be sent with the class you specified.

Related Topics

Interpreting Status Tokens
Sending a Message



Attaching Files

"Attaching" is the process of sending files, and/or the Windows clipboard along with your message.    

Attaching allows you to share your DOS and Windows files (spreadsheets, executables, graphics, even 
the Windows clipboard) and share them with anyone on the network. 

How To

1. Press the Add Files button in either the Envelope or Edit Mail Message window.

A File Attachments window will open up.

2. Select the file that you wish to attach to your message.

You can type the path and filename directly into the line edit box, or choose from the list below.

3.Once the name of the file you wish to attach is in the filename window, click on Add to add it to 
the Attachment list.
If you change your mind, simply select the erroneous file and click on Remove.

5. When the Attachment list contains all the files that you want Attached to your message, click on
the appropriate button to continue the message creation process.

Related Topics

Changing Your Address Book
Attaching the Clipboard     



Attaching the Clipboard

In addition to attaching DOS and Windows files to send with your message, you can attach the Windows 
clipboard.

How To

1. Press the Add Files button in either the Envelope or Edit Mail Message window.
A File Attachments window will open up. 

2. To attach the contents of the Windows clipboard, click on Clipboard.
A window will open for you to type in a name for your clipboard attachment.

3. Enter a name and click on OK.
The contents of the Clipboard will be added in the Attachment list.

4. Click on the appropriate button to continue the message creation process.
For instance, if you want to go to the Deliver box, click on Deliver. 

Related Topic

Attaching Files



Certifying a Message

Certified Mail is a handling classification used to notify you when your message is read.    Upon reading 
the message, the receiver's eMAIL will send you a receipt.

How To

1. In the Deliver Box (the box in which you specify the receivers of a message), click the Certified 
button.

If the Certified button is checked when you send your message, your message will be sent Certified.

Related Topic

Sending a Message



Changing Your Address Book

An address book is a list of people to whom you commonly send mail.    

(Note: Your administrator maintains a Public Address Book, and you do not have to create a Personal 
book unless you send mail regularly to people who are not in the Public list.)

How To Edit the Address Book

1. Choose Address Book from the Names menu.
A window will open for you to edit your Personal Address Book.

- To add a new name, type the name into the line edit box and press <Enter>.
 
Valid eMAIL names use only letters, numbers, spaces, hyphens, underscores, and the number symbol 
(#).    Names can contain up to 23 characters.

- To delete a name, select the name from the list and press Delete.    

- To change a name, select the name from the list and press Rename.
 A window will open up for you to type in the new name and press OK.

- To add or change a route, select the name from the list and press Route.
A window will open for you to type in the route and press OK.

(Note: If the address is local, you do not enter a route.    The route is for names which require eMAIL to 
cross a gateway into another system.    Refer to the specific gateway manuals for the required routes.)

After You Edit the Names

1. Press OK to close the Edit Address box.

2. Choose Save from the Names menu.
 A window will open up for you to check the address book.

3. Check Address book.

4. Press OK.

Related Topics

Address book
Using the Receiver List



Changing Your Password

How To

1. Choose Change Password from the Options menu.
 A Change Password window opens up.

2. Type in your name and your CURRENT password.
 (If you have forgotten it, ask your eMAIL administrator.)

3. Press OK.
 An Enter Password window opens for you to enter your new password.

4. Enter a new password 

5. Enter your new password again into the Verify New Password box.

6. Press OK.

Related Topic

Change Password



Closing eMAIL

Closing eMAIL ends your eMAIL session.    Closing eMAIL is different from minimizing it, because eMAIL 
is still active when it is minimized. However, when eMAIL is closed, it does nothing until you run it again.

How To

1. Select Close from the System menu in the eMAIL Window.
The System menu is pulled down from the System Box: the '-' sign in the upper-left-hand corner of any 
Microsoft Window.    You can achieve the same effect without pulling down the menu by double-clicking on
the System Box.

This will end your eMAIL session.    The eMAIL icon will disappear.

Related Topic

Minimizing eMAIL



Creating a Message

1. Click on the Create! menu.
A Create Message window opens.

2. Type in the Subject.

3. <Tab> to the Message envelope and type in your message.
Do not press the <Enter> key when you want to start a new line: eMAIL will do this for itself.    To start a 
new paragraph, press <Enter>.

Related Topics

File Menu
Edit Menu
Editing a Message
Sending a Message
Using Multiple Names Files
Using the Receiver List



Deleting a Message

Deleting a message removes it permanently from your mailbox.

(Note: You can keep a printed copy or a text file copy, but deleting the message reduces the size of your 
mailbox.)

How To

1. Select the message that you want to delete.

2. Choose Delete message from the Mailbox menu.
A warning window will open up.

3. Press OK to confirm your decision to delete the message.

Related Topics

Delete message
Multiple Selection
Printing a Message
Saving Your Messages



Editing a Message

Arrow keys move around the text. <Del> and <Backspace> keys remove unwanted text. 

Moving Through the Message

<Home>: Moves to the beginning of a line.

<End>: Moves to the end of a line.

<PgUp>: Moves up by one page if possible.

<PgDn>: Moves down by one page if possible.

Note that <PgUp> and <PgDn> may not be possible if you are too far up or down in a message.

Cut-Copy-Paste (Moving Blocks of Text)

<Shift>-: Holding the <Shift> key down while you move through the message "selects" the text you
move over for cutting, copying, and pasting.

Mouse Dragging: Holding the left mouse button down and moving through the text "selects" the text
you move over; this is the mouse equivalent of the <Shift>-Move keyboard combination discussed above.

The following are options in the System menu: the menu that is pulled down from the gray '-' in the Edit 
Mail Message window.

Cut: Deletes the selected text into the Windows clipboard.

Copy: Copies selected text into the Windows clipboard without deleting it.

Paste:Pastes the contents of the clipboard into the message (wherever the cursor is).

Related Topic

Creating a Message



Encrypting a Message

eMAIL allows you to encrypt messages with a special password known only to you and the recipient.

How To

1. Confer with the receiver(s) and agree on a password.
A password is any combination of up to fifteen characters.

2. In the Deliver Box, click the Security button.

3. A window opens up for you to type in the encryption password.

4. Press OK to return to the Deliver Box.
The message will be sent Security, and the recipient will not be able to read it without the proper 
password.

Related Topic

Sending a Message



Inserting Text Files Into Your Message

A pre-existing document can easily be sent through eMAIL as part of a message, and can even be edited 
for the message without being changed in the original file.    This is different from Attaching because the 
inserted file actually becomes part of your message instead of being sent along with it.    Note that while 
any kind of file can be Attached to a message, only ASCII files can be inserted into a message.    Even 
word processing files cannot be inserted unless you save them without formatting.

How To

1. Select Open from the File menu in the Create Mail window.
When you select Open from this menu, the Open File window will open.

2. Enter the path and name of the text file you wish to insert into your message.
You can type the path and filename directly into the line edit box, or choose from the list box below.    

3. Click on Open.
The document will appear in the message wherever the cursor was left, without deleting the rest of your 
message.    The file is now a part of your message; you can edit it along with your regular message before
sending.

Related Topics

Attaching Files
Creating a Message
Sending a Message



Interpreting Status Tokens

Status Tokens

These single-character tokens provide quick information about a message.

! Priority mail.
1,2,3 What "class" a non-priority message was sent.
A Indicates that files have been attached to the message.
N A new message (one that has not been read yet).
C A carbon copy
B A blind carbon copy.
S A Security (encrypted) message.

Related Topic

Assigning a Message Class



Minimizing eMAIL

Turning eMAIL into an icon is called minimizing it, and is a standard feature of Microsoft Windows 
programs.

How To

1. Click on the small down arrow in the upper-right-hand corner of the eMAIL Window.
The eMAIL Window disappears, and the eMAIL Icon (a small envelope) appears in the lower-left-hand 
corner of your screen.    You can then work on other Windows programs and ignore eMAIL.    

2. Double-click on the eMAIL Icon.
eMAIL comes back just as it was. 

Related Topic

Selecting a Mail Alert



Multiple Selection

1. Press <Shift-space bar> (or <Shift-mouseclick>). 
This puts you in multiple select mode: you can then select as many items as you wish by repeating <Shift-
space bar> on each item.    Delete message and other appropriate functions will perform on all the 
highlighted items.

2. If you select an item by pressing space bar or the mouse button without the <Shift> button 
down, you will be out of multiple select mode.

Related Topic

Deleting a Message



Printing a Message

How To

1. Select the message which you want to print.

2. Choose the menu option Print message from the Mailbox menu.

(If the message is not printed properly, you may want to check your Windows Control Panel to make sure 
the printer is set up correctly.    See your Microsoft Windows documentation for more details.)

To print out a large number of your eMAIL messages quickly:

1. Multiple select all the messages at once. 

2. Choose Print message.    
The messages will all be printed on separate pages.

Related Topic

Print message list



Printing Names Lists

You can print a list of names in:

-the Public Address Book 
-the Public Mailing Lists 
-your Personal Address Book
-your Personal Mailing Lists    
-the Login Names List

How To

1. Choose Print from the Names menu.
A Print Lists window will open up.

2. Check the buttons for the lists that you want to print.

3. Press Ok to Print.
The printouts will be made.



Receiving Security Messages

When you receive Security Mail... 

1. eMAIL will ask you for a password before it shows you the message.    

2. Give the correct password to read the message.    
The message will be encrypted in your mailbox, and the password will be required each time you read it.

Related Topic

Encrypting a Message



Replying to a Message

How To

1. View the message to which you want to Reply.

2. Click the Reply button in the View Message window.
A Reply to Mail window appears.    The Subject will be filled in automatically

4. Type the message.

5. The Receiver of your message is automatically the person who sent the message to which you 
are replying.
Note that you must reselect such options as Class, Security, and carbon copies, as they will not carry 
over from the original message.
 
6. Send the message as you normally would.

Related Topics

Creating a Message
Sending a Message



Saving Attached Files

"Saving": storing an attached file in your DOS system.

The "A" status token in the mailbox is used to inform you that a message has files Attached to it.    You 
can transfer these files from eMAIL to your computer system so that you can use them later.    This 
process is called "Saving" the files.

How To

1. Select the message which has Attachments you want to extract.

2. Choose the menu option Save attachment from the Mailbox menu.
The Save Attachment window will open up.

3. Double-click on the file name that you want to save.
The file will not yet be saved; the save File As window will open up:

4. Type the path and filename that you want to save the file as.
If you press Ok without making any choice, the file will be saved in the directory that you ran eMAIL from, 
and will retain its original name.    

5. Press Ok.
The file will be saved to the directory and file name that you specified.

6. If you choose to save your message with a file name that already exists, a window will open.
If you press Ok, the old file will be removed from your system and replaced by the file that you are saving. 
If you do not want to eliminate the old file, press Cancel and choose another name.

Related Topics

Attaching Files
Inserting Text Files



Saving Your Messages

"Saving": Creating a text file which contains the contents of an eMAIL message; or, appending the 
contents of an eMAIL message to a pre-existing text file.

How To

1. View the message which you want to save.

2. From the File menu,choose the menu option Save. 
A Save Editor Text window will open up:

3. Type the path and the filename that you wish to save your message to.

4. Click Word-Wrap on if you want to word-wrap your message.
If you choose this option, eMAIL will insert a carriage return after every line.    Some text editors require 
these carriage returns.    If you will be reading your message into such an editor, the button should be on 
when you save.    

However, eMAIL's text editor and most other word processors know how to automatically start a new line 
when the old one ends; if you will be reading your message into such an application, leave the Word-
Wrap button off.

5. If you choose to save your message to a file name that already exists, the File Exists window 
will open.
You now have the choice of either overwriting the file name that you chose, or appending your message 
to that file.    If you choose to overwrite, the old file will be deleted and your message will replace it.    If you
choose to append, your message will be appended to the end of the old file.

NOTE: Never append an eMAIL message to a non-text file.  Appending to a spreadsheet or executable, 
for instance, could have very dangerous results.

Related Topic

Inserting Text Files



Searching Your Mailbox

When eMAIL searches your mailbox, it displays only the messages that you want. The other messages 
are not gone; they are simply not shown on the screen.

How To

1. Choose Search messages from the Mailbox menu.

A Search Messages window appears for you to specify search criteria.    Only messages that meet all the 
specified criteria will be displayed.

-To search for messages from a specific    author, type the user's name in the field labeled Name.

-To search for messages by subject, enter the critical words in the field labeled Subject.

-To search for messages sent on or after a certain date, enter that date in the Date Start field.

-To search for messages sent on or before a certain date, enter that date in the Date End field.
If the same date is entered in both fields, only messages received on that day will be displayed.

-To restrict the search to a specific type of mail (e.g. New, Security, etc.), press the appropriate 
button.
(Note: Only one of the class buttons can be on at one time.)

-To restore the full mailbox, the Search Mail window must be cleared: all buttons must be turned 
off and all line edit boxes must be blank.

(Note: If you EXIT eMAIL with a searched mailbox without clearing the Search Messages window, your 
full mailbox will be restored the next time you run eMAIL.

Related Topics

View message
Viewing a Message



Selecting a Mail Alert

If you are sent a message while eMAIL is in icon form, eMAIL will inform you that you are receiving a 
message.    This is known as a Mail Alert.

The Mail Alert can take one of four forms:

1. A tone sequence may sound.

2. A popup window (described below) may appear and give you the option to immediately view the 
message.

3. Both the tone and the popup may be used.

4. Neither the tone nor the popup may be used - in other words, no mail alert.

Choose by clicking Incoming Beep and/or Incoming Popup in the Options menu. A check means you will 
get a beep and/or popup; no check means no beep and/or popup. 

Note: The popup appears right in the middle of whatever you are doing, and gives you two choices: Ok 
(read the message later) and View (read the message now but be returned to your application after 
viewing).    

Related Topic

Minimizing eMAIL



Sending a Blind Carbon Copy

Blind carbon copies work the same as ordinary ones, except that the "true" recipients are unaware that 
carbon copies are being sent. The receivers of the copies get a "B" status token instead of a "C".    

1. To send Blind Carbon Copies, click on the Bcc button (instead of the Cc button). 

2. Build the list exactly as you would ordinary carbon copies.

NOTE: In some companies, sending blind carbon copies is considered unethical.    Find out if your 
company has a policy on Blind Carbon Copies before you use this option.

Related Topic

Sending a Message



Sending a Carbon Copy

"Carbon Copies": copies of a message which go to addresses other than the person to whom the 
message was written.

The receiver of a carbon copy will get a C status token with the message.    At the bottom of your 
message, eMAIL will automatically list the people who were sent carbon copies, so the receivers of the 
message can see who received copies.

How To

1. In the Deliver Box (the box in which you specify the receivers of a message), click the Cc: 
button.

2. Enter a name that you want to receive a carbon copy of the message.
You can enter this name by typing it into the line edit box, or by choosing it from the list on the left.

3. Click on Add to add the name to the Cc: list.
Repeat steps 2 and 3 for as many names as you want to receive carbon copies; the names will all appear
in the Cc: list on the right as you add them.

4. When the Cc: list contains all the names that you want to receive Carbon Copies, press Ok.
You will now be returned to the Deliver Box.

When you send the message, it will go to all the people on the Carbon Copy list in addition to the people 
in the To: list.

Related Topics

Interpreting Status Tokens
Sending a Message



Sending a Message

After you have written your message in the Create window, you will click on Deliver to open a Deliver box 
to send the message.

1. Click on a name in the Receiver List.
The name will appear in the User name(s) box to indicate that this user will receive a copy of the 
message.

2. Click the mouse on another name in the Receiver List.

3. When the User name(s) box contains all the correct names, click on Send to deliver the 
message.
eMAIL will dispatch a copy of your message to each of your designated receivers, and the Message sent 
successfully window will appear.

4. Click on Yes to acknowledge the message.
You will now be returned to the eMAIL window.

Related Topics

Assigning a Message Class
Multiple Selection
Using the Receiver List



Setting the Hot Key

While you are running some other program, you can press a hot key (a key sequence) to pull up a Create 
window whenever eMAIL is in icon form.    After you have sent the message, you will be returned to your 
previous program.

1. In your eMAIL window, select Set Hot Keys from the Options menu.
The Set Hot Keys window will open up.

2. Click on Choose, then key in any combination of one character in conjunction with any 
combination of the <Shift>, <Ctrl>, and <Alt> keys.

3. Click on Finish.
The combination you chose will be displayed in the window.

4. Click on OK.

Related Topics

Minimizing eMAIL
Set Hot Keys



Using Help

On-line help is frequently faster, easier to use, and more convenient than any paper manual.

How To 

1. Choose Help Index from the Help menu.
This will bring up the Help Index screen.

Double-clicking on a topic will present you with the topic or a list of subtopics.    

The Buttons

There are five buttons in the Help screen.    These five buttons are features of Microsoft Windows 3.0.    
For more specific information about these buttons and the Windows Help menu options (File, Edit, 
Bookmark, and Help), refer to the Windows manual or the Windows on-line help.

Index: Returns you to the main Help Index.

Back:    Displays the last topic you viewed.          

Browse >>: Shows the previous topic in a series of topics.

Browse <<: Displays the next topic in a series of topics.

Search: Lists the Help keywords which you can select or type to receive topic information.

Related Topic

Welcome



Using Mailing Lists

A mailing list is a collection of eMAIL names that can be referred to by one name.    As an example, 
*Advert might stand for everyone in your advertising department.    

Deleting and Renaming Mailing Lists

1. Select Mailing lists from the Names menu.

2. Select a name from the list.

3.Press delete to delete the list, or Rename to rename it.
If you choose Rename, a box will pop up for you to type in the new name.

4. After you press OK, save your changes: see "Saving Changes to Your Mailing Lists" below. 

Editing and Adding Mailing Lists

1. Select Mailing Lists from the Names menu.
This opens the Edit Mailing Lists window.

2. To add a new list, type the name and press <Enter>; to edit an old list, double-click on the 
mailing list which you want to edit.
Note: All mailing list names must start with an asterisk (*).

- To add a new name to the Mailing List, double-click on the name in the Receiver List.

- To delete a name from the Mailing List, select the name from the Mailing List (on the right) and 
click on Delete.

- To give a Route in the Mailing List, select the name from the list in the right and press Route.
A small window will appear for you to type in the route.        

3. Press OK to return to the Edit Mailing Lists window.

4. Press OK to close the Edit Mailing Lists window and save your changes by the process 
described below.

Saving Changes to Your Mailing Lists

1. Choose Save from the Names menu.

2. A window will open up for you to check Mailing Lists.

3. Press OK.
The changes you made are saved until you change them again.    If you do not save the changes, they will
be gone when you run eMAIL again.

Related Topics

Mailing lists
Using the Receiver List



Using Multiple Logins

More than one person can be logged into eMAIL on the same computer at the same time.

Logging people in and out

Logging people in and out means adding and removing Login Names.    

1. Choose Logins from the Names menu to open up the Login Names window.

-To add a name, type the name and press Add.    

-To remove names, select them in the list and press Delete.    

-When you press Ok, you will be asked for the passwords of the people who are logging in.

Changing which mailbox is open 

1. Select Open mailbox in the Mailbox menu
A list box will open containing the names of all the people who are logged into eMAIL at your station.    

2. Choose from this list box the mailbox that you want to open.    
That mailbox will be displayed, and the currently open mailbox will close.

Choosing who a message is sent from 

When multiple users are logged in, the From list box in the Create window contains all the users' names 
in it.    Choose the name that the message should go out from.

Related Topics

Change Password
Open mailbox
Sending a Message



Using Multiple Names Files

All the names and routes in your Personal Address Book are stored in a DOS file commonly known as the
"Address Book"; all your Personal Mailing Lists are kept in a DOS File known as the "Mailing List File."    

If you are operating in a very large network environment, you may find it inconvenient to deal with files 
that contain hundreds of names.    

You have the option of creating more than one file.    Because only one Address Book and one Mailing List
File can be open at a time, this functionality allows you to work with only the names you need at the 
moment.    By opening different files at different times, you can keep all the names you need handy.

Note that nothing below affects the Public Names; these options only switch around your Personal Names
in the Receiver List.    This entire section applies to Login Names, Address Books, and Mailing List Files.

Overview: The Three Steps that Create a Names File

1. Open a New (empty) file.
This process is described below in "Opening a New File."

2. Edit the file.
To edit your Address Book, Mailing List, and Login Names files, see editing sections under the 
procedures, "Changing Your Address Book," "Using Mailing Lists," and "Using Multiple Logins." 

3. Save the file with a new name.
This process is described below in "Saving a File with a New Name."

Once you have created, edited, and saved a file, all you need to know is how to Open that file; this 
process is described below in "Switching Between Files."

Opening a New File

Note: Use the Save menu option before creating a new file,so that you do not lose the old file.

1. Choose New from the Names menu.
A window will open up for you to enter new names.

2. Check the files that you want to create.
Note that you can check both Address Book and Mailing Lists if you want to create both lists from scratch.

3. Click on Ok.
The lists you specified will now be empty; for instance, if you created new Mailing Lists, there will be no 
Mailing Lists in your Receiver List (except the Administrator-defined Public Lists).    You can start building 
new Mailing Lists with the processes described in "Using Mailing Lists." Once you have built them, you 
should save them with the process described below.

Saving a File with a New Name

If you want to save a file without losing the old version, you must save the new book with a new name, so 
that the old book will remain intact.

1. Choose Save As from the Names menu.
The Save As File window will open up.

2. Check the file that you want to save.
Note that you can only save one file at a time this way.    If you want to save your Address Book and 



Mailing Lists with new names, you must go through this process twice.

3. Type the path and name that you want to save the list with.
Remember, names lists are stored as DOS files.    You can use any valid DOS filename you like, although 
the recommended extensions are .NMY for Login Names, .NMT for your Address Book, and .NMG for a 
Mailing List File.

4. Check Okay to save the specified list with the specified name.

Switching Between Files

When you open a Names File, the previously open file will not be deleted; however, the old file will close, 
and any changes that you have made and not saved will be lost.    To save changes, use the Save menu 
option before opening a new file.    

1. Choose Open from the Names menu.
The "Open File Name" window will appear.

2. Select the file name that you want to open.
The file should be a Names List that you have previously created.    You can type the path and filename 
directly into the line edit box, or choose from the list box below.    

3. Click on Open.
The file name that you specified will now be loaded into eMAIL.    For instance, if it was a Mailing List File, 
it will replace your previous Mailing Lists in the Receiver List.

Related Topics

Changing Your Address Book
Printing Names Lists
Using Mailing Lists
Using Multiple Logins
Using the Receiver List



Using the Receiver List

The Receiver List is the list from which you choose the recipients of your message.    It consists of the 
Public Address Book, the Public Mailing Lists, the Personal Address Book, and the Personal Mailing Lists.

How To

1. In the Deliver Box, click on a name in the Receiver List.
The name will appear in the User name(s) box.

2. To add other names, hold the <Shift> key down, and click on another name in the Receiver List.

Related Topics

Changing Your Address Book
Sending a Message
Using Mailing Lists



Viewing a Message

Your normal mailbox display includes a list of all the messages in your mailbox.

How To 

1. Double-click on the message that you want to view.
(You can also use the up-and-down arrows to highlight the message, and then press <Enter>.)    A View 
window will open up.

2. Read the message.

3. When you are finished reading the message, click on OK to return to your mailbox.
    
Related Topic

View message




